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1. Introduction 

Cscreen is an “electronic broker tool for OTC equity derivatives”. It is used as a bulletin 
board to publish Indications of Interests (IOIs) and trades. There is no automatic matching 
and all trades are finalised over the phone. Cscreen also has a simple chat function 
where brokers and traders can chat with each other in real time. 

There is also an Excel link that exports prices to Excel, which can be used to apply 
certain calculation models to the prices. 

Cscreen is one of Liffe’s three services for wholesale equity derivatives. These three 
services are fully integrated to provide straight-through processing (STP) from pre-trade 
price discovery to post-trade registration, administration and clearing.  

The other two services are: 

• Bclear, the “on-exchange” administration and clearing service  

• Afirm, the OTC Post-Trade Matching service, which will offer affirmation or matching 
as a route to confirmation for OTC ISDA-based transactions 

Cscreen can either be used as a stand-alone service or in conjunction with one of the two 
post-trade services (Afirm and Bclear), allowing users to register trades directly from 
Cscreen. 

Further information about the three services is available on request from Liffe. Tel: + 44 
(0)20 7379 2200 or email: equities@liffe.com, or from the website: 
www.nyx.com/cscreen. 
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2. Accessing Cscreen 

Before you start to use Cscreen you must register as a user (broker or trader), see 
Registering as a User. 

Once you have been registered and have received your e-mail confirmation, you can log 
in to Cscreen. There are two options:  

• Cscreen Lite – a java applet  

• Cscreen Pro – requires Java Web Start (see Java Web Start). 

2.1 Broker and Trader Access 

Brokers and Traders have access to different functionality in Cscreen. The main 
differences are described below:  

2.1.1 Order Management 

Brokers: 

• Are entitled to a full view of their own order book. 

• May expand orders, a function that allows them to see the full order book for the 
selected instrument. 

• Can enter trades 

• Can perform Price Routing 

• Have the option to see either All Orders, Flagged Orders, Internal Orders, Orders with 
Order Status or Flagged Events. 

Traders: 

• Have the option to see either Top of the Book Orders, Internal Orders, Flagged 
Orders, Orders with Order Status or Flagged Events. However, they cannot see the 
full depth of the market. 

2.1.2 Trades Management 

The broker and trader views of the Trade Log are slightly different: 

Brokers  

• May enter comments, which can only be seen by brokers belonging to the same 
company 

Traders  

• Cannot see the comments fields but have access to all the normal order details.  
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• Has a broker field to see who was trading. 

2.2 Technical Requirements and Security 

2.2.1 Java Web Start  

Cscreen Pro requires Java Web Start (JWS) which is a technology for simplifying 
deployment of Java applications. It makes it possible to launch fully featured applications 
with a single click from within a Web browser. You can download and launch applications, 
such as a complete spreadsheet program or an Internet chat client without going through 
complicated installation procedures.  

For more information about JWS and to download the application go to 
http://java.sun.com/products/javawebstart/ and follow the instructions. 

Note: To install Java Web Start you need privileges to install programs on your computer. 
If you have any problems with this please talk to your IT staff. 

2.3 Registering as a User 

1. Enter the URL www.cscreen.com in your browser window. 

2. Select whether to register as a broker or a trader by clicking the appropriate link 
either Register Broker or Register Trader. A registration page is displayed. 

3. Complete the registration form and click the Submit button. An agreement page is 
displayed. 

4. Read the agreement and click the OK button. 

Once you have agreed to the registration terms you will receive an email confirming 
that you have been registered as a Cscreen user. 

2.4 Logging On 

1. Enter the URL www.cscreen.com in your browser window. 

2. Click either the Cscreen Lite or Cscreen Pro button.  

Alternatively for Cscreen Pro, click the  icon on your desktop. 
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On initial use, Cscreen Pro will display a Java Web Start window and download the 
Cscreen application. You will be prompted to grant privileges to the application, click 
the Start button to proceed.  

You will also be prompted about creating a desktop shortcut to the application. 

3. Enter your username and password. The password field is case sensitive. 

4. Click the OK button. By logging on you accept the Cscreen disclaimer. 

The main window is displayed. 

The first time you run Cscreen it may take a while for the application to load. 

2.4.1 Changing your Password 

1. On the Tools menu, select Change Password. The Change Password window is 
displayed. 
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2. Enter your existing password followed by new password. 

3. Confirm the new password by re-entering it and click the OK button. 

2.5 Logging Off 

1. On the File menu, select Exit or close the application window. 

2. Click the OK button on the confirmation window. 
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3. Main Window 

The following example shows the Cscreen Pro main window for a broker: 

 

The top left pane lists instrument groups by geographical area. Expand a group to view 
the constituent instruments in the group. User specified groups can be defined, see 
Instrument Groups.   

The top right pane is the Order book.  

For Brokers it contains all the orders submitted by brokers in the firm. Orders in the order 
book can be cancelled, suspended or resumed, see Order Actions. 

For Traders it contains all the prices from all brokers or those defined in the Broker group, 
see Specifying Bank/Broker Groups. 

The order book can be filtered to show either: 

• All Orders (Default - Broker)  

• Top of the Book (Default - Trader) 

• Flagged Orders 

• Internal Orders  

• Orders with Order Status. 

See Filter Orders in the Order Book. 
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The columns displayed can be customised, see Customising the Cscreen GUI. 

The bottom pane displays the information for a selected tab. The default tab is Events. 
The tabs access Trades, facilities to chat to logged in users either Brokers/Traders, 
Colleagues or Support and send trades to either Bclear or Afirm if they have the 
appropriate permissions.  

The data displayed can be sorted by clicking the column headings. 

Right-clicking the order book displays options to enter and manage orders, switch flag 
status and send orders to Afirm or Bclear. 

For brokers, right-clicking a trade on the Trades tab accesses options to modify or cancel 
the trade. 

The window layout is the same for a trader. All prices displayed are indicative.  

The status bar shows the number of users currently logged in. 

3.1 Customising the Cscreen GUI 

You can configure Cscreen GUI to best suit your particular needs. Functions that can be 
customized include: 

• Banks/Brokers - allows brokers to define their bank groups and traders to define 
their broker groups, see Bank/Broker Groups.  

• Instruments – (Brokers only) specify which instruments will trigger an alert when an 
incoming order is received. 

• Order Book Columns – specify which columns of data are displayed in the Order 
Book, see Specifying which Columns are Displayed. 

• Chat – specify how chat messages are displayed.  

• Colours – specify the colours displayed and timeout values to alert you when a new 
price is received or a price changes in the Order Book. Specify whether tabs should 
flash when their content changes, see Changing Colour Settings. 

• Mail – specify how mail messages are displayed. 

• Sounds – specify audible alerts for orders, trades or chat messages. 

• Clearing – specify the url for Bclear and Afirm. 

• Order Validity – (Brokers only) specify parameters for the suspension of orders. 

• Order Entry Defaults – specify the default parameters for order submissions. 
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3.2 Groups Management 

3.2.1 Bank/Broker Groups 

By default Cscreen contains the names of all Cscreen users. You can define which users 
should be part of the My Banks/Brokers or All Banks/Brokers groups.  

Defining these groups serves several purposes: 

• It allows brokers to define which banks (and therefore which traders) are shown in the 
Logged in Traders tab as My Banks or All Banks. 

• It allows traders to define which brokers are shown in the Logged in Brokers tab as 
My Brokers or All brokers. 

• It defines for both traders and brokers which banks/brokers are available for 
order/RFQ entering. 

Note: By default All Banks/Brokers are shown on the different tabs. If you want to show 
only your Banks/Brokers, on the View menu, select Show Only My Banks/Brokers. 

3.2.1.1 Specifying Bank/Broker Groups 

1. On the main window, click the Customize button. The Customize window is 
displayed. 

Alternatively, on the Tools menu, select Customize. 
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The following example shows the Customize window for a Broker which shows the 
Banks tab: 

 

2. Click the Banks/Brokers tab. For brokers the tab is shown as "Banks", for traders it 
is shown as "Brokers". 

3. To add specific members, select the individual bank/broker and click the  
button to add them to My Banks/My Brokers list.  

Hold down the ‘Ctrl’ key whilst selecting members and click the  button to move 
them across to My Banks/My Brokers. 

To deselect group members, select them and click the  button. The selected 
members will revert back to the All Banks list.  

The lists can be edited at any time and are saved in Cscreen on exit. 

All the banks that a broker has added to the My Banks list are available in the Bank field 
in the Price Information area on the Enter Order window. They are also shown in the 
Logged In Traders tab, if Show Only My Banks is selected on the View menu. 

Similarly for a trader, all the brokers added to the My Brokers list are available in the 
Broker field in the Price Information area on the Enter Order window. 
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3.2.2 Instrument Groups 

Instrument Groups are displayed in the Instrument Groups pane.  

An instrument group can be defined for an individual and for all the users in a firm. 

An individual group can be accessed from the My Groups folder.  

An instrument group available to all the users in the firm can be defined and accessed 
from the Our Groups folder. 

3.2.2.1 Searching for Instruments 

1. In the Instruments Groups pane, enter part of the name of the instrument or its 
contract code in the Search field. The drop-down displays instruments or contract 
codes that match the criteria entered. 

2. Select the required instrument or contract code from the drop-down. 

3. Press ‘Enter’ to display the Enter Order window, see Entering an Order. 

3.2.2.2 Creating an Instrument Group  

1. In the Instruments Groups pane, select the location for the new instrument group 
either My Groups or Our Groups. 

2. Right-click the relevant folder and select Compose/Edit Groups.The Compose 
Instrument Groups window is displayed. 

 

The Manage Groups drop-down will display the selected group. 

3. Click the  button to add an instrument group. 
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4. Enter a name for the new instrument group and click the OK button.  

5. Sort the instruments by Stock or Index using the filters at the top. 

6. Select the instruments using the ‘Shift’ or ‘Ctrl’ key and click the  button to 
move them to the Selected Instruments. 

7. Click the OK button. The group is shown in the Instrument Group pane as a subfolder 
of the selected group either My Groups or Our Groups.  

The process can be repeated any number of times although it should be noted that 
My Groups are only visible to the individual user logged in.  

8. Once your group has been created, on the Tools menu select Refresh Groups to 
arrange the groups alphabetically.  

Alternatively, you can use the ‘drag and drop’ functionality as follow: 

1. Expand the folder by clicking the ‘+’ button. 

2. Select the instrument(s) by holding the ‘Shift’ or the ‘Ctrl’ key to make multiple 
selections. 

3. Right-click the instruments and drag your selection to the relevant folder either My 
Groups or Our Groups. You can also drag one or more instrument folders, left-click 
and drag. 

4. Enter a name for the instrument group and click the OK button. The group name is 
shown as a sub-folder.  

3.2.2.3 Deleting a Group 

1. In the Instrument Groups pane, right-click the group to be deleted and select Remove 
Group/Instrument. The group is removed. 

3.2.2.4 Deleting an Instrument in a Group 

1. In the Instrument Groups pane, select the required folder either My Groups or Our 
Groups. 

2. Right-click the instrument to be deleted and select Remove Group/Instrument. The 
instrument is removed from the group. 

3.2.3 Specifying which Columns are Displayed 

Columns in the Order Book, Event and Trade tabs can be customised. 

1. Click the Customize button or right-click a column heading and select Customize 
columns. The Customize Columns window is displayed. 

Alternatively on the Tools menu, select Customize. On the Customise window, select 
the Order Book Columns tab. 

The following example shows the options available when you right-click the Order 
Book column heading and select Customise Columns: 
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2. Select the columns to be displayed, the following options are available: 

Flag Displays the flag icon if an order is flagged 

Underlying Name of the underlying instrument 

Legs Legs of the strategy 

Struct Structure of the order, see Supported Structures 

Ratio Leg ratio 

Ref. Reference Price 

Event (Event tab) Name of the Event 

Price (Event tab) Price bid x volume or price offered x volume for both 
brokers and traders 

Actor (Event tab) Broker firm acting on a price/structure 
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Bid Bank (Order Book for Brokers only) Displays the name of the bank 
assigned to the bid  

Bid Broker (Order Book for Traders only) Displays the name of the broker 
assigned to the bid 

Bid Routing For a Trader either: 

 Internal (I): The price is only visible to other users in this 
bank and is not visible to any brokers (or banks). It can be 
used as a 'whiteboard'. 

 Broker (B): This is a price that either you have entered and 
assigned to a broker, or a broker has created and assigned 
to you. 

For a Broker either: 

 Internal (I): The price is only visible to other users in this 
brokerage and is not visible to any banks (or brokers). It can 
be used as a 'whiteboard'. 

 All (A): This price is visible to all banks (but no other 
brokers). 

 Trader (T): This is a price that a trader has entered and 
assigned to you. 

 Multicast (M): This is a price that you have given specific 
routing conditions to. This means that you have chosen a 
group of traders who may see the price and others who will 
not. Traders do not know what routings you have assigned 
to their prices. 

Bid Status Displays either  About to Trade and  Trading, see 
Switching the Order Status 

Bid Displays price x volume for the bid, see also Viewing an Order 
Summary 

Offer Displays price x volume for the offer, see also Viewing an Order 
Summary 

Offer Status Displays either  About to Trade and  Trading, see 
Switching the Order Status 

Offer Routing See Bid Routing for details 

Offer Bank (Order Book for Brokers ony) Displays the name of the bank 
assigned to the offer 

Offer Broker (Order Book for Traders only) Displays the name of the broker 
assigned to the offer 

Delta Delta value of the structure 

Time (Event tab) Time the event occurred 

Comment (Event tab) Displays the free text entered 

Change Displays the time of the most recent price change to either the 
bid or offer 

Bclear Contract A Bclear contract is shown as B, see Viewing the Bclear 
Contract Specification 

Validity (Order Book) Displays the validity of the order, ‘Suspend End of 
Day’ (SED) or ‘Cancelled End of Day’ (CED) 
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Type Displays the type of transaction either OTC (O) or exchange-
traded (X) order 

Style Displays the option style either European or American 

Market Depth (Order Book for Brokers only) Click  to display or hide the 
market depth  

Bid Comment Displays the free text entered 

Offer Comment Displays the free text entered 

Traded At (Trade tab) Displayed as Traded Price x Traded Volume 

Trade Routing (Trade tab) See Bid Routing for details. 

  

3. Select your preference for column resizing.  

4. Click the OK button. The settings are stored between sessions. 

3.2.4 Changing Colour Settings 

1. Click the Customize button. The Colours tab is displayed by default. 

Alternatively, on the Tools menu, select Customize.  
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2. Change the colour settings for each option by selecting a colour. 

3. Specify whether the tab should flash when the content changes. 

4. Modify the number of seconds for the colour change timeout period.  

5. Click the OK button to store your preferences. 

3.3 Setting Filter Preferences 

A Filter Group defines the instrument and order parameters which will be shown in the 
Order Book, the Event and Trades tab. For example, selecting UK single stocks as the 
filter will show all the orders, trades and events relating to UK single stocks. 

1. In the Instrument Groups pane, right-click My Filter Groups and select Compose/Edit 
Groups. The Compose Filter Group window is displayed. 

 

2.  Enter the name for the filter group. 

3. Enter or select the instrument parameters. 

4. Enter or select the order parameters. 

5. Click the OK button. The new filter group is shown in My Filter Groups. 

6. Select the filter group. The Order Book, Events and Trades tab display data related to 
the filter preferences defined in the group. 
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4. Order Management 

Order Management is the core Cscreen function. The Order Book allows users to view 
and manage orders in the market. 

4.1 Events Tab 

The Events tab displays all price additions, amendments and any changes made to the 
structures, each event has a timestamp. Events are listed as they occur in real time so 
information is broadcast instantly to all users. The tab flashes when there is a new event. 
The default colour is grey, but this can be changed (see Changing Colour Settings). The 
information displayed is always chronologically listed by default but can be sorted by any 
of the columns. Events on a flagged instrument are highlighted, see Flagging. 

Note: the Events listed are lost once a session has ended and are not saved on exit.  

The tab displays the changes made to the market/group selected in the Instrument 
Groups pane. Selecting ‘Groups’ in the Instrument Group pane will display all events 
reported across all markets. 

The tab updates only when a user is logged in therefore a trader/broker who has been 
logged in all day will see all the events logged during that day, whereas one who has just 
logged in will only see the events that occur after their login. 

The following are examples of the events displayed: 

• New Trade 

• Trade Cancelled 

• New Structure 

• New Price 

• New RFQ. 

4.2 Order Actions 

Brokers can enter orders and trades; traders can only enter orders. 

An order can be entered, modified, cloned, traded, suspended or even cancelled if 
desired. 

4.2.1 Entering an Order  

1. In the Instrument Group pane, double-click or right click the required instrument and 
select Enter Order. The Enter Order window is displayed.  
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The following example shows the Enter Order window for a broker: 

 

2. Complete the following fields: 

Underlying Displays the underlying of the instrument selected 

Structure Type Select the structure of the order 

Type Select either FIX or FLOAT option type. Defaults to FIX or defined 
Order Entry Default. 

O/X Select either OTC (O) or exchange-traded (X) order. Defaults to X or 
defined Order Entry Default. 
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Style Select European or American style. Defaults to A or defined Order 
Entry Default. 

Legs 

Ratio The number of legs is determined by the structure type selected. 

In some structures you can specify whether the Calls or Puts are 
more expensive. Click the Change Ratio Polarity button to switch 
the ratio of the legs, thereby changing which of them is more 
expensive.  

Legs must be entered with the nearest expiry first. Hence, 
sometimes it will be necessary to change the ratio polarity. 

Leg Type Defaults from the structure type or can be selected. 

Expiration Expiry date in MMMYY format. 

Strike Strike must be entered as an integer value >= 0.01.  

If FLOAT was previously selected (on an OTC option) the strike will 
revert to a percentage format and the expiration will be DDMMMYY. 

Price Information 

Reference Price Becomes the basis if FLOAT was selected as Type. 

Delta Optional. Delta value of the structure. 

Price Bid/Offer 

Volume Can be left blank and modified later. 

Bank (Broker only). Counterparty of the order - only shown internally. 

Broker (Trader only). Name of the broker who is sent the order. 

Comment Optional. Comments are shown to the selected recipients of the 
trade routing group in the Order Summary. 

RFQ Request for Quote.  

No price or volume required. 

SED (Only available to Brokers). 

Select this box to keep orders active at the end of the day, which 
means the orders will still be here when the market opens on the 
following business day. When this box is unchecked, the order will 
be automatically cancelled at the end of the current business day. 

Price Routing (Note: only available to Brokers) 

All banks Select a group (or individual bank) from the All Banks list this defines 
who will see the price at any point in time. For example, select best 
clients first and then add other clients at a later time. 

Logged in banks are shown in black otherwise they are shown in 
grey. 

Offer recipients The banks the broker sends the offer price to. 

Bid Recipients The banks the broker sends the bid price to. 

Bid & Offer De-select the box to send the bid and offer price to different 
recipients. 
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3. A broker can select the banks to which the order will be routed as follows: 

To include banks in the trade routing, select the banks and click the  button to 
add it to the recipients.  

To exclude specific banks, select All banks and click the  button to add it to the 
recipients. Select ‘Block’ followed by the banks to be excluded from the routing and 

click the  button. The excluded banks are shown with their names crossed out. 

Alternatively, click the Manage Groups button. Create a group and add members to 
it. 

4. Click the OK button. The order is displayed in the Order Book. 

4.2.2 Modifying an Order 

1. In the Order Book, right-click the bid or offer column of an order and select Modify 
Order. The Modify Order window is displayed with the applicable order details.  

The following information can be modified: 

- Reference Price and Delta 

- Bid and offer information  

- Price Routing information (Brokers only). 

2. Alternatively, double-click the Bid or Offer (which is then shown with a yellow 
background). Enter the new price and press ‘Enter’. 

3. If the Bid has improved with the same order then enter the new Price and/or Volume 
and click the OK button. Likewise with an Offer. A price change will be highlighted in 
the Order Book in the colour specified on the Customise window, see Changing 
Colour Settings.  

4.2.3 Cancelling an Order 

1. In the Order Book, click the Cancel button. The Cancel Multiple Orders window is 
displayed. 
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2. Select the order(s) to be cancelled and click the OK button. The order is cancelled. 

Alternatively, right-click an order (on the bid or offer column) and select Cancel 
Order.  

Select a number of orders by holding down the Ctrl key, right-click and select Cancel 
Multiple. 

4.2.4 Suspending an Order 

You may temporarily suspend all your orders. This may be required when you are away 
from your desk or unavailable and the price is no longer firm.  

Suspended prices are greyed out and cannot be modified until resumed. 

1. In the Order Book, click the Suspend button. The Suspend Multiple Orders window is 
displayed. 
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2. Select the order(s) to be suspended and click the OK button. The order is suspended.  

Alternatively right-click an order (on the bid or offer column) and select Suspend 
Order.  

4.2.5 Resuming an Order 

1. In the Order Book, click the Resume button. The Resume Multiple Orders window is 
displayed. 

2. Select the order(s) to be resumed and click the OK button. The order is resumed. 

Alternatively right-click an order and select Resume Order. 

4.2.6 Cloning an Order 

An existing order can be used to provide the details for a new order.  

1. In the Order Book, right-click the bid or offer column of an order and select Clone 
Order. The Clone Order window is displayed with the applicable order details 

2. Modify the order details as required and click the OK button. 

4.3 Filtering Orders in the Order Book 

1. In the Order Book, select the criteria to filter by from the drop-down list: 

By default ‘All Orders’ are displayed in the order book for brokers. The default for 
traders are orders at the ‘Top of the Book’. 

‘Flagged Orders’ are orders that have been flagged for attention by a broker or a 
trader, see Flagging. 

‘Internal Orders’ are those that have been routed to the ‘Internal’ group by a broker so 
can only be viewed within the firm. A trader can specify ‘Internal’ in the Broker field 
when submitting an order.   

‘Orders by Order Status’ displays orders which are about to trade or are trading, see 
Switching Order Status. 

‘Flagged Events’ displays order related events flagged for attention by a broker or a 
trader in the Events tab. 

4.4 Viewing an Order Summary 

1. In the Order Book, hover the cursor over the Bid or Offer column of an order 
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4.4.1 Viewing Broker Details (Trader Only) 

1. In the Order Book, double-click a Bid Broker or Offer Broker column or right-click and 
select Show Broker Details. 

 

4.5 Viewing the Bclear Contract Specification 

1. In the Instrument Group pane, right-click an instrument and select Show Bclear 
Contract Spec.  

Alternatively, in the Order Book contracts that are available on Bclear denoted by ‘B’ 
in the Bclear Contract column. Double-click to display the contract specification. 

 



 Trades Management (Brokers Only) 

 

   
Cscreen User Guide Released  Page 26 of 38
 

5. Trades Management (Brokers Only) 

Brokers can enter a trade by either: 

• Trading an order in the Order Book 

• Entering trade details for an instrument in the Instrument Group pane and publishing 
an external trade. 

The counterparties involved in the trade are not disseminated to the market. 

Entering the volume for a trade is optional. 

5.1 Trades Tab 

The Trades tab displays the trades for the market or group selected in the Instrument 
Group pane. Selecting ‘Groups’ in the Instrument Group pane will display all the trades 
reported across all markets. 

5.1.1 Trading an Order 

1. In the Order Book, right-click the Bid or Offer column of an order and select Publish 
Trade. The Publish External Trade window is displayed. 

5.1.2 Publishing an External Trade 

1. In the Instrument Group pane, right-click the required instrument and select Publish 
Trade. The Publish External Trade window is displayed for the instrument selected.  
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2. Enter the traded price. Traded volume is optional. 

3. It is possible to submit the trade to Bclear or Afirm by selecting the required option. 

4. Select the banks to which the trade will be routed as follows: 

To include banks in the trade routing, select the banks and click the  button to 
add it to the recipients.  
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To exclude specific banks, select All banks and click the  button to add it to the 
recipients. Select ‘Block’ followed by the banks to be excluded from the routing and 

click the  button. The excluded banks are shown with their names crossed out. 

Alternatively, click the Manage Groups button. Create a group and add members to 
it. 

The trade is shown on the Trades tab and is broadcast to the recipients in the trade 
routing group. 

5.1.3 Switching the Order Status 

Changing the order status indicates to traders that an order is either ‘About to Trade’ or is 
‘Trading’.  

If an order is ‘About to Trade’, this indicates to traders that they have to act if they want to 
trade as a price is about to be traded. ‘Trading’ shows that a price is being agreed. This is 
to deter traders from calling brokers as the trade is being executed. 

1. In the Order Book, right-click a price and select ‘Switch Order Status’ to display  
‘About to Trade’ or  ‘Trading’.  

Alternatively, double-click the column on the left of the bid or right of the offer to 
switch the status. 

5.1.4 Modifying a Trade 

1. In the Trades tab, right-click a trade and select Modify Trade. The Enter Trade Details 
window is displayed.  

2. Modify the details as appropriate and click the OK button. 

5.1.5 Cancelling a Trade 

1. In the Trades tab, right-click a trade and select Cancel Trade. The trade is removed. 
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6. Flagging 

The flag functionality can be used to easily follow a market, an instrument or an order.  

It is possible to flag: 

• Orders 

• Instruments 

• Instrument groups 

• Global groups. 

Flagging is available to all users. 

Flags can be removed as required or when the session ends. 

6.1 Flag Inheritance 

All events that take action on a flagged instrument/order will be shown in the Event Log in 
a different colour (the same colour as for the flagged orders in the Order Book). 

• If you flag a group (instrument or global) all underlying members of that group will be 
flagged automatically.  

• If you flag an instrument you will flag all existing and future orders on this underlying 
until you un-flag that instrument, or single orders on that instrument.  

If you have flagged an instrument group you can un-flag individual instruments 
separately. The same goes for global groups. 

6.1.1 Flagging an Order 

1. Right-click either an order, instrument or group (instrument or global) and select Flag 
or Switch Flag Status. The flagged order will be highlighted in a different colour and 
marked with a flag icon in the orderbook. 

Alternatively double-click the flag column of an order. 

6.1.2 View Flagged Orders 

1. In the Order Book, select Flagged Orders from the drop-down list. The order book is 
filtered to display the flagged orders.  

Alternatively, in the Order Book sort the flagged orders by clicking the first column 
heading. 
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6.1.3 Flagging an Event 

1. An event can be flagged in the same manner as an order: right clicking on the event 
and select ‘Flag’ or double click on the flag column of an event. 

6.1.4 View Flagged Events 

1. Flagged events can be filtered by selecting ‘Flagged Events’ option from the filter 
dropdown box. 

2. Flagged events can be sorted by clicking on the ‘Flag’ column header on the Events 
tab. 
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7. Sending E-mails 

Cscreen includes functionality to let brokers and traders send e-mails regarding an order.  

7.1 Sending an E-mail from Cscreen 

1. In the Order Book, right-click a bid or offer price and select Send Mail. Your mail 
program will open with a mail containing the details of the specified order.  

Note: there will be an XML statement at the bottom of the email. This is clearly 
marked and should not be removed. It may be used by automated systems on the 
receiver's end.  

Alternatively, an Internet browser window will open if you have selected the 
‘Alternative way to send emails’ on the ‘Customize’ menu (only available in Cscreen 
Pro). 
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8. Chatting 

It is possible to chat with other Cscreen users and with Cscreen support. The chat 
function is available to both Brokers and Traders, from the three tabs Logged In 
Traders/Brokers, Logged In Colleagues and Logged In Support. 

A chat tutorial is shown on each of the tabs. 

Note: if you do not have Cscreen active when you get a chat message you will get an 
audible alert and the text “New Chat Msg” will flash in the taskbar. 

8.1 Logged in Traders/Brokers Tab 

The Logged in Traders/Brokers tab allows the broker/trader to see authorized 
traders/brokers logged into the system.  

There are two possible views: 

• All Banks/Brokers - shows all the banks/brokers that Cscreen has to offer. This is the 
default view.  

If you want to see only your Banks/Brokers, select Show Only My Banks/Brokers from the 
View menu. 

• My Banks/Brokers - shows a selection that the user has created from the 
Banks/Brokers tab in the Customize window. 

Note: some Banks and Traders are hidden and therefore invisible. Your customers can 
make themselves visible to you by contacting Cscreen at support@cscreen.com 

Note: it is currently not possible to chat with API users. 

8.2 Logged in Colleagues Tab 

The Logged in Colleagues tab allows the broker/trader to see colleagues who are logged 
into the system.  

8.3 Logged in Support Tab 

The Logged in Support tab allows the broker/trader to see support personnel logged into 
the system. 

8.3.1 Starting/Ending a One-to-One Chat Conversation 

1. Select either the Logged in Traders/Brokers, Logged in Colleagues, Logged in 
Support tab.  

2. Right-click a colleague’s name or username and select Send Message. The chat 
session will be visible to the right.  
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3. Enter your message at the bottom of the chat session area and click the Send button. 
Your message will be shown to you and the recipient of the message at the top of the 
chat session area. 

4. Right-click the text area and select whether to end or clear the chat session. 

Messages to and from you will be shown in different colours, and new messages will be 
placed on top (depending on your customisation, see Customising the Cscreen GUI). 

Many chat sessions occur at the same time. Every chat session you start will be shown 
on a new tab, named with the initials of your counterpart. 

As a Broker, you can specify a nickname to be used instead of your initials, contact 
Cscreen Support to set this up. 

8.3.2 Starting/Ending a One-to-Many Chat Conversation 

1. Select either the Logged in Traders/Brokers, Logged in Colleagues, Logged in 
Support tab.  

2. Hold down the Ctrl key and select several users. 

3. Right-click a user and select Send message. 

4. Enter your message in the dialog box displayed and click the OK button. The chat 
sessions will be visible to the right. Your message will be shown to you and the 
recipients of the message in the text area above. 

5. Right-click the text area and select whether to end or clear the chat session. 

Note: if one of the recipients in a one-to-many chat conversation replies only to the 
sender of the message, he will get the reply message. 
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9. Excel Feed (Cscreen Pro only) 

Cscreen Pro has the functionality to let users feed order data for selected underlyings into 
Excel. This can be done in the following ways: 

• From the Instrument Group pane 

• From the Customize Excel window 

Note: in order to be able to use the Excel feed functionality the application must be run 
under Java Web Start. You must also run a Microsoft Windows operating system, and 
have Microsoft Excel installed. 

9.1 Selecting an Instrument to Feed to Excel 

1. Right-click an underlying/Instrument Group/Global Group in the Instrument Group 
pane and select Feed group/instrument to Excel.  

The underlying/group is now selected to be fed to Excel (indicated by an Excel logo 
icon in the Instrument Group pane). 

2. Excel is started (if necessary) and a new workbook opens (unless you have specified 
one in the Customize window). 

The data for this instrument or group of instruments will be written into Excel. You can 
add further instruments in the same way, by repeating the steps above.  

New instruments will be added to the bottom of the current list in Excel. These 
settings will be saved when you close Cscreen. 

Alternatively, select the instruments on the Customize Excel window, see Customize 
Excel. 

9.2 Start/Stop an Excel Feed 

1. On the Excel menu, select Feed prices to Excel. Cscreen starts Excel and begin 
feeding orders into it. 

To stop an Excel feed, de-select Feed prices to Excel. This action will leave Excel 
open but stops live updates of the sheet.  

If you select the same option again, updates will continue. 

9.3 Customising Excel 

1. On the Excel menu, select Customize. The Customize Excel window is displayed. 
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2. Select whether to create a new Excel workbook or use an existing one. 

If you opt to use an existing workbook the browse button will become available. 
Browse to the location of the file. 

3. Select the instruments to feed to Excel using the   buttons. 

4. If applicable, click the Advanced button to select the language and the timeout value 
if the connection to the server is lost. 

5. Click the OK button. 
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10. Sending Trades to Bclear or Afirm 

It is possible to use Cscreen to enter trades to the Post Trade Cleared Service (Bclear) 
and Post Trade OTC Matching Service (Afirm). The user will need to login to Bclear or 
Afirm first. 

To submit trades to Bclear or Afirm either: 

• When entering a trade select "Submit to Bclear" or "Submit to Afirm 

• Right-click an instrument and select "Send to Bclear" or "Send to Afirm" 

• Right-click a price and select "Send to Bclear" or "Send to Afirm" 
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Appendix A. Supported Structures 

The following list details the available structures: 

ABBREVIATION DESCRIPTION 

CALL Call 

PUT Put  

BOX Box 

CALL_CALD Calendar Call Spread 

CALL_CONDOR Condor Call Spread 

CALL_DIAG Diagonal Call Spread 

CALL_FLY Call Butterfly 

CALL_LADD Call Ladder 

CALL_RATIO Ratio Call Spread 

CALL_SPD Vertical Call Spread 

PUT_DIAG Diagonal Put Calendar Spread 

EFP Equity For Physical 

GUTS Guts 

ICONDOR Iron Condor 

IRON Iron Butterfly 

MISC Miscellaneous (used for user-defined strategies). Use the Comment field 
to enter text about the strategy. 

PUT_CALD Calendar Put Spread 

PUT_FLY Put Butterfly 

PUT_LADD Put Ladder 

PUT_RATIO Ratio Put Spread 

PUT_SPD Vertical Put Spread 

ROLL Roll 

ROLL_JELLY Jelly Roll 

ROLL_SYNT Synthetic Roll 

RR Risk Reversal 

RR_CALD Calendar Risk Reversal 

STRD Straddle 

STRD_DIAG Diagonal Straddle 
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ABBREVIATION DESCRIPTION 

STRD_HDG Delta Neutral Straddle 

STRG Strangle 

STRG_CALD Calendar Strangle 

SYNT Synthetic 

CALL_CONDOR Condor Call Spread 

PUT_CONDOR Condor Put Spread 

FORWARD Forward 

CALL_SPD_SWP Call Spread Swap 

CALL_SPDvP Call Spread v Put 

CALL_SPDvPUT_SPD Call Spread v Put Spread 

PUT_SPD_SWP Put Spread Swap 

PUT_SPDvC Put Spread v Call 

DIV_SWAP Dividend Swap 

RR_RATIO Ratio Risk Reversal 

RR_SWAP Risk Reversal Swap 

TRS Total Return Swap 

VAR_SWAP Variance Swap 

VAR_SWP_SPD Variance Swap Spread 

VOL_SWAP Volatility Swap 

 

 


